Software FX, Inc.
5200 Town Center Circle
Suite 450
Boca Raton, Florida USA
33486
Phone: (800) 392-4278
(561) 999-8888
Fax: (561) 998-2383
sales@softwarefx.com
www.softwarefx.com

Software FX Ltd.
Broad Quay House
Prince Street
Bristol, UK
BS1 4DJ
Phone: +44 (0) 117 905 8733
Fax: +44 (0) 117 905 8833
www.softwarefx.co.uk

Software FX Germany
Postfach 19 05 25
80605 München
Deutschland
0800-CHARTFX
Phone: +49 (089) 1216 25-33
0800-CHARTFX
Fax: +49 (089) 1216 25-34
www.softwarefx.de

Technical Support
Phone: (561) 392-2023
support@softwarefx.com

www.softwarefx.com

Any Chart, Anywhere!

Chart FX OLAP
Quick Start Guide

www.softwarefx.com

Chart FX OLAP Quick Start Guide
Table of Contents

Page

Introduction................................................................................................................1
What is Chart FX OLAP? ...................................................................................1
What’s included on the CD..................................................................................2
Chart FX OLAP Requirements........................................................................2
Adding Chart FX OLAP in a VS.NET application .........................................3
Chart FX OLAP Navigational Interface ...........................................................4
Menus on Demand..............................................................................................5
Toolbar.....................................................................................................................5
Automatic Legends and Titles .......................................................................5
Color Persistence.................................................................................................5
Drag & Drop Pivoting .........................................................................................5
XP and Windows 2000 Category Bar..........................................................5
Connecting Chart FX OLAP with sample data ............................................6
Connecting to real multidimensional data sources .............................6
Chart FX OLAP and Web Forms Internet/intranet applications.........7
Pricing and Licensing ..............................................................................................8

Information in this document is subject to change without notice and does not represent a commitment on the
part of Software FX, Inc. The software, which includes the information contained in any databases, described in
this document is furnished under a license agreement or nondisclosure agreement. The software may be used or
copied only in accordance with the terms of those agreements. It is against the law to copy the software on any
medium except as copy of the software for backup purposes. No part of this manual may be reproduced or
transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, or information storage and retrieval systems, for any purpose other than the purchaser's personal use, without the express
written permission of Software FX, Inc.
Software FX, Inc. disclaim all warranties, either express or implied, including but not limited to implied
warranties of merchantability and fitness for a particular purpose, with respect to the instructions contained
in this manual. In no event shall Software FX, Inc. be liable for any damages whatsoever including, without
limitation, damages for loss of business profits, business interruption, loss of business information, or other
pecuniary loss, even if Software FX, Inc. has been advised of the possibility of such damages. Because some
states do not allow the exclusion or limitation of liability for consequential or incidental damages, the
above limitation may not apply to you.
©1993-2003 Software FX, Inc. All rights reserved.
Printed in the United States of America.
Chart FX is a registered trademark of Software FX, Inc.
Other products and brand names are trademarks or registered trademarks of their respective owners.

Introduction
Companies worldwide use relational databases and OLAP to increase the
productivity of business managers, developers, and whole organizations.
OLAP enables organizations to respond more quickly to market demands.
Market responsiveness, in turn, often yields improved revenue and profitability.
Developers also benefit from OLAP for a simple reason: end users of OLAP
applications can become more self-sufficient since they are no longer dependent
on IT to make schema changes, to create joins, or build their own models.
Unfortunately, most if not all, OLAP vendors provide standalone applications that
are expensive, proprietary and provide limited deployment options. If you want
to OLAP-enable your intranet of enterprise applications, read on—Chart FX OLAP
may just be the right solution for you!

What is Chart FX OLAP?
Chart FX OLAP is the first .NET OLAP front end for developers that seamlessly
integrate to Visual Studio .NET allowing you to build and deploy fully OLAP
provisioned charts in your Windows Forms and Web Forms applications.
Chart FX OLAP virtually connects to any relational database through ADO-MD
and XML for Analysis serving as the only data analysis charting solution geared
for developers and integrating to major leading OLAP server vendors such as
Microsoft SQL Server®.
Chart FX OLAP picks up the information and presents the hierarchical structure
to the user in an intuitive way, enabling users to pivot, slice and dice data to
uncover vital information. All this end user functionality is provided with little
or no intervention from the developer, thus reducing development time and
increasing customer satisfaction
Also, as a fully managed .NET component, Chart FX OLAP is a sensibly priced
solution that supports a myriad of deployment scenarios, so whether you are
building a browser based intranet application or a commercial or enterprise
grade application, Chart FX OLAP is the right solution for you!

561.999.8888

www.softwarefx.com

800.392.4278

1

What’s included on the CD?
The CD bundled with this package provides a fully functional 60-day trial version
of Chart FX for .NET and Chart FX OLAP. With it you can connect to your own
OLAP data source and build Windows Forms or Web Forms applications with
Visual Studio .NET.
If you are not a developer or technical person, please ask someone in your
organization to put up a quick Chart FX OLAP application demo for you. There
are also over 20 minutes of tutorial movies that can be viewed without having
to install any applications. You may find yourself one step closer to deploying the
most powerful OLAP functionality for a lot less than what you are paying today!

Chart FX OLAP Requirements
Below are the minimum requirements to use the Chart FX OLAP software
contained in the CD:

• Chart FX for .NET (version 6.0.1200 or later).
• Microsoft .NET Framework (1.0 and above) and Visual Studio .NET
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Adding Chart FX OLAP in a VS.NET application
1 Open Visual Studio .NET and select the New Project from the File Menu.
2 Add Chart FX for .NET to your toolbox.

• Selects Tools-> Customize Toolbox.
• Select the .NET Framework Components tab and check the Chart control
checkbox. Important: use the SoftwareFX.ChartFX namespace if you created
a Windows Forms applications or SoftwareFX.ChartFX.Internet.Server if you
want to use Chart FX OLAP in a Web Forms project.

• Once you have selected the chart control, click Ok.
3 Draw the Chart FX control to the form. If the Chart FX for .NET wizard pops-up
select a side-by-side bar chart from the wizard gallery and exit the wizard pressing
the Finish button.
4 Chart FX OLAP acts as an extension to Chart FX for .NET. Therefore you need to
add the OLAP Extension references to the project. Select Project -> Add Reference.
From the Component list, select the ChartFX OLAP Extension, ChartFX Category Bar
Extension, and the Interop.ADOMD components.
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Chart FX OLAP
Navigational Interface
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Menus on Demand
Each dimension tab features an icon that provides access to
different options such as sub categories selection and summary
functions. This icon provides immediate and intuitive access to
each dimension subcategories.
Toolbar
Chart FX for OLAP Toolbar provides end users
access to powerful charting functionality such as
3D, rotation, axis settings, chart gallery, printing,
exporting straight from the browser or application!

Automatic Legends and Titles
Chart FX for OLAP assigns Legends and Titles
automatically according to the selections made
by end users in the category bar.

Color Persistence
Chart FX for OLAP provides a state-of-the-art color
coding algorithm that renders chart markers and
icons with unique and identifiable colors throughout
the analysis process, considerably improving the
chart's readability.

Drag & Drop Pivoting
Pivot or transpose data in the chart by dragging
the Legend box or X-axis labels.

XP and Windows 2000 Category Bar
Located in the left hand side of the chart allows users to navigate
from all available dimensions and levels contained in the OLAP cube.
For added convenience, this interface accommodates Windows XP
(shown), Windows 2000 and browser views.
All elements are accompanied with a checkbox that enable end
users to easily filter additional data displayed in the cube, every user
interaction is automatically and immediately displayed in the chart.
5

Connecting Chart FX OLAP with sample data
For evaluation purposes, we have included a portable binary file that allows you to
test Chart FX OLAP free from the bounds of connectivity to a real OLAP data source.
This binary file contains multidimensional information from the Food Mart 2000
database, which is included with Microsoft SQL Server: Analysis Services package.
On a production level, however, you will be required to use ADO-MD or XML for
Analysis to populate the chart with real multidimensional data.
Included with the Chart FX OLAP installation, you will find a sample directory
where a file named OLAPCHART.BIN is located. In order to test Chart FX OLAP,
you will need to instruct Chart FX OLAP to load this file, as follows:
In Visual Studio .NET, Double-click the form to access the code editor for the
form. Type the following code in the Form_Load event handler to import the
OLAPCHART.BIN binary file. In a Windows Forms applications, the Form_Load
statement should look as follows:
Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As
System.EventArgs) Handles MyBase.Load
Chart1.Import(SoftwareFX.ChartFX.FileFormat.Binary,
"C:\Program Files\Chart FX OLAP\OLAPCHART.BIN")
End Sub

Connecting to real multidimensional data sources
If you are interested in populating Chart FX OLAP with data coming from your
own OLAP database, you can do it via ADO-MD or XML for Analysis.
If you are using SQL Server with Analysis Services, your best option is to use an
ADO-MD connection and let Chart FX OLAP read from it automatically. The following
code snippet can help you connect Chart FX OLAP to your existing database:
Dim Olap1 As New SoftwareFX.ChartFX.Olap.OlapExtension()
Dim ADOMD1 As New SoftwareFX.ChartFX.Olap.AdoMultiDimensionalData()
Dim connStr, ds As String
connStr = "Provider=msolap; Data Source=**YourServerName**;Initial
Catalog=FoodMart 2000;"
ds = "SELECT {[Store].[Store Country].[USA].Children} ON
COLUMNS,{CROSSJOIN(Descendants([Gender]),
Descendants([Time].[1997]))} ON ROWS From [Sales]"
ADOMD1.Connect(connStr, ds)
Olap1.DataSource = ADOMD1
Chart1.Extensions.Add(Olap1)
Olap1.Refresh()
Note: For additional information on XML for Analysis please refer to
the Chart FX OLAP Help file and code samples included with the CD.
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Chart FX OLAP and Web Forms Internet/intranet applications
Not only has Chart FX OLAP been developed with the server implementation in
mind, but its small memory footprint and scalability makes it the perfect tool for
any commercial or corporate grade application. Also, the Chart FX OLAP .NET
client control can be easily and securely deployed across the organization via a
single file download from the Internet Explorer browser.
Performance wise, Chart FX OLAP can serve a multitude of end users with
sub-second charts and the solution is fully scalable and compatible with intricate
server architectures, such as web-farms.
The picture below depicts a browser-based intranet application using Chart FX OLAP.
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Pricing and Licensing
Chart FX OLAP requires Chart FX for .NET, which is sold and licensed separately.
If you are using Chart FX OLAP in a Windows Forms application, you will need
a single license that allows you to build applications, end users are royalty free
for distribution.
For Web forms applications, Chart FX OLAP is priced on a per server basis; clients
are royalty free for distribution. This pricing model is perfect for software vendors
looking to OEM Chart FX OLAP or corporate customers looking for an affordable,
yet powerful, OLAP charting solution. For more information on licensing and pricing
please contact sales@softwarefx.com or call us at (561) 999-8888.
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Pure .NET Charts,
Not from a Wrapper.
As .NET ripens, Chart FX for .NET is the
pick of the crop. Chart FX was completely
rewritten in C#—not using custom manageable
wrappers!—and will exist within .NET as
MANAGED CODE. This ensures that Chart FX
will be completely compatible to utilize all
of the features and performance of .NET,
including improved security, easier integration
with web services, enhanced XML support,
new API, multiple format image generation
(including JPG, GIF, PNG, SVG and ActiveX)
make use of the transparency, anti-aliasing
and gradients in the new GDI+. And we can’t
forget the new Windows XP look and feel.

Chart FX for .NET

